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SYSTEM COMPONENTS 

MAIN SYSTEM COMPONENTS 

SANAKO STUDY TUTOR APPLICATION 
Teachers use the Study Tutor application, which is the main 
interface to the Study 500/1200 system. The Tutor 
application allows teachers to instruct with the Study 
500/1200 system and to control the classroom computers. 

SANAKO STUDY STUDENT APPLICATION 
The Study Student application is installed onto all student 
computers. Study Student connects to SANAKO Crossroad 
at system startup and runs in the background listening for 
commands from Study Tutor. Students can open the student 
interface to work independently, however, teachers are able 
to control student computers, regardless of whether the 
Student application is visible on student screens or not. 

SANAKO CROSSROAD 
The SANAKO Crossroad server program is the information 
center of the SANAKO Study system and both the Tutor and 
Student components automatically connect to it. All system 
data is passed through SANAKO Crossroad and it allows 
communication between the Tutor and Student components. 
If you do not have a separate server computer, you can 
install SANAKO Crossroad onto the same computer as 
Study Tutor. 
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COMPONENTS RELATED TO DYNAMIC LICENSING  

SANAKO LICENSE SERVICE 
License Service is a server module (Windows service) that 
handles license reservation requests from student or tutor 
applications. It is also responsible for handling automatic 
procedures related to license lease expiration in servers. 

SANAKO LICENSE MANAGER 
License Manager handles general license administration 
tasks; adding and removing licenses to and from the 
database and editing existing licenses.  

SANAKO LICENSE DATABASE – LICENSE 
POOL 
License Database stores the license data that is handled by 
the License Service according to license use requests in the 
network 
 
Note: these components are only needed when the dynamic 
licensing option is selected during installation of the Study 
system. 
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REQUIREMENTS 

MINIMUM REQUIREMENTS FOR TEACHER AND 
STUDENT PC 

 

• Microsoft® Windows® XP or Windows Vista operating 
system 

• Microsoft .NET Framework® 1.1 or 2.0 

• DirectX 9.0c 

• 1 GHz processor 

• 512 MB of system memory, 1 GB recommended for 
Tutor PC 

• 100 MB of free disk space for installation * 

• 1024*768 display resolution with 16-bit colors 

• AC97 or HDA compatible sound card 

• Network Adapter, TCP/IP support required 

• PC Headset – recommended SANAKO models to 
ensure high quality audio 

• QuickTime® 7.0.3 or later is required for displaying 
certain file types and for the SANAKO Study Video 
Live Module 

*) The amount of free disk space required during the use of Study 1200 
varies primarily according to the use of the recording functionality - longer 
recording times require more disk space. 

Note: Actual requirements may vary based on your system 
configuration. It is essential to make sure that the operating 
system runs smoothly on each computer where a Study 
Tutor or Student application will be installed.  

NETWORK REQUIREMENTS 
The following requirements should be met by the network. 

• Student and teacher workstations should be located 
on the same TCP/IP sub-net 
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• Student and teacher workstations should be able to 
PING each other and the Crossroad with TCP/IP 
packets. 

• It is recommended that all the workstations within the 
room are connected to the same network switch with 
support for Multicast transmission. 

• Minimum of 100B bandwidth or greater dedicated to 
each workstation. 

FIREWALL SETTINGS 
The following programs have to be added to the firewall 
exceptions or the firewall has to be disabled.  

• Rsrv.exe (Crossroad computer/server) 
• Tutor.exe (Teacher computer)  
• Student.exe (Student computers)  

 
The default TCP ports used by SANAKO are: 

• PORT 6100 for command packets 
• PORT 6131 for screen multicast packets 
• PORT 5060 for audio packets 
• PORT 6121 for screen monitoring packets 

SUGGESTED NETWORK DIRECTORY STRUCTURE 
We recommend that you structure your network as shown 
below – below example is designed for Study 1200 users. 
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The amount of hard disk space required for the storage of 
digitized files depends on how much material will be made 
available to the students at any one time and how much work 
the students are likely to save to their own area. Disk quota 
sizes usually vary between 20 and 50MB per student. 
However, students using Study 1200 typically require a disk 
quota of 100MB minimum to allow them to save work during 
class for self-study reinforcement. 
A typical MP3 audio file size (default setting in Study 1200) is 
approximately 1MB per minute. 
Therefore, a typical 160GB hard disk drive would allow for 
the saving of approximately 2600 hours of audio.  
In order to ensure that this information can be delivered to all 
the student desktops simultaneously (i.e. smooth video and 
audio playback) SANAKO strongly recommends the use of 
hardware RAID controllers on the server or the use of 
Network Attached Storage (NAS) devices. 
SANAKO also recommends that you take regular data back-
ups. The use of a CD/DVD writer is also recommended to 
save student oral recordings and/or source material that are 
infrequently used. When this material is required it can be 
copied to the server from the CD archive. 
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INSTALLATION 

LICENSING METHODS 
Before installing SANAKO Study software you need to 
decide on a Study licensing method. From Study 500/1200 
v.3.0 onwards it is possible to choose between two different 
licensing methods. 

LOCAL LICENSING 
When using local licenses the license information is stored in 
Windows Registry on Teacher computer.  

DYNAMIC LICENSING 
When using Dynamic Licensing, product licenses will be 
added to an SQL Express Database using the SANAKO 
License Manager application. Tutor application will reserve a 
license from the License database after it has been started 
and the connection to XRD is established. Student 
applications will reserve licenses from the licenses database 
after they join the classroom of an active Tutor. Licenses will 
be returned to License database after Students leave the 
tutor’s classroom or after Tutor disconnects XRD. 
This means that customers can deploy the solution to any 
room (or combination of rooms) so long as the total number 
of users at any one time does not exceed their concurrent 
user licenses 

RECOMMENDED INSTALLATION ORDER WHEN 
DYNAMIC LICENSING IS USED 

When dynamic licensing is used, we recommend that the 
different components are installed in the following order: 

1. SANAKO License Service Database and License 
Manager 

2. Study components: Crossroad, Tutor and Students 
Note: If the Study system is installed using Local Licensing 
you can skip the SANAKO License Service Database and 
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License Manager installations and start directly with the 
Study components installation. 

INSTALLATION INSTRUCTIONS 

LICENSE SERVICE DATABASE & LICENSE 
MANAGER INSTALLATION 
Follow the installation instructions below to install License 
Service Database and License Manager 

1. Select License Service Database in the Installation 
CD menu to start the installation program 

2. Click Accept the license terms to start Setup 
Program 

 
3. It is recommended to exit all Windows programs 

before running the Setup Program. Click Next to 
continue. 
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4. Select a destination location for the License Service 
Database installation. Click Next to continue with the 
default destination folder or click Browse… to change 
the default destination folder. 

 
5. Setup Program is ready to begin the installation. Click 

Next to start the installation. 
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6. Setup program has begun installing License Service 
Database. It may take a few minutes to finish.  

 
7. The License Service Database installation is now 

complete. Click Finish to exit Setup Program. 
Continue system setup by adding Study 500 and 
Study 1200 licenses to the License Service Database. 

 
 

ADDING STUDY LICENSES TO THE LICENSE 
SERVICE DATABASE 
Follow the instructions below to add Study licenses into the 
License Service database 

1. Open the License Manager application via Windows 
Start menu: Start/All Programs/SANAKO License 
Service/License Manager.  

2. Insert the information below to the login fields and 
click Login to log in to License Manager Application. 
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Data source: SANAKO License Service. 
Username: sanakoservice 
Password: 5anako5ervice 
 

 
3. Click Detailed view to continue. 

 
4. Click Add… to open Add license window 
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5. Enter the Study license information to the license 
number, license user and license key fields. There is 
no need to fill the other fields displayed in the add 
license window. Click Add to add a license to License 
Service Database. 

 
6. The added licenses are now visible in the License 

Manager window. 

 
After Study licenses have been added to the License Service 
database you can continue with Study 500/1200 installation.  
 

STUDY 500/1200 TUTOR AND CROSSROAD 
INSTALLATION 
Follow the installation instructions below to install Study 
500/1200 Tutor and Crossroad applications 

1. Start installation program by selecting Study Tutor in 
the Study installation CD menu 
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2. Select Tutor and system components and click 
Continue 

 
3. Click Accept the license terms to start Setup 

Program 
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4. Select a target installation folder, application type, 
components and licensing method.  

You may select between the following applications 
• Tutor 1200 
• Tutor 500 
• Crossroad components only 

Tutor 1200 or Tutor 500 should be installed on the 
Teacher computer and by default Crossroad will be 
installed along with the Tutor installation. This is 
recommended if you do not have a separate server 
computer for the Crossroad installation. If you do have 
a separate server computer, install the Tutor 500/1200 
application onto the Teacher computer and SANAKO 
Crossroad onto the server computer.  
Remember to uncheck the ‘Crossroad components’ 
selection when installing Tutor 500/1200 applications 
only – refer to the picture above  
Select your licensing method by checking between the 
following options:  

• Study uses local license for this classroom only 
• Study leases license from Sanako License 

Server 
5. When installing Tutor 1200 or Tutor 500 application, 

you need to define the IP address or name of the 
computer where Crossroad will be installed. Click 
Install to start installation. 
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Note: If you selected ‘Crossroad components’ 
installation, the above dialog will not be displayed. 

6. Click Finish to complete the installation and to restart 
the Teacher PC  

 
 

STUDY 500/1200 STUDENT INSTALLATION 
Follow the installation instructions below to install the Study 
Student application. 

1. Start installation program by selecting Study Student 
in the Study installation CD menu 
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2. Click Accept the license terms to start Setup 
Program 

 
3. Click Install to start the Study Student installation. 

You may also change the target installation folder by 
clicking Change… 
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4. Define the IP address or name of the computer where 
the Crossroad is installed and click Continue. 

 
5. Select whether to associate common media files with 

the Study Student application. We highly recommend 
that media files are associated to the Student 
application, especially when setting up a Study 1200 
classroom. Click Continue to proceed with installation 

 
6. Click Finish to complete installation 
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UPGRADE INSTRUCTIONS  
Due to major changes in the Study Software it is not possible 
to use the Study update mechanism when upgrading from 
previous Study versions to version 3.0.  
We recommend that you read all the upgrade instructions 
carefully before starting to upgrade your current Study 
software 

STUDY STUDENT UPGRADE 
Study Student software can be upgraded according to 
instructions described in the technical document How to 
upgrade Study applications from previous versions to version 
3.00.doc, available on the SANAKO Web site.  

STUDY TUTOR AND CROSSROAD UPGRADE – 
DYNAMIC LICENSING 
If you have decided to use dynamic licensing, you can 
upgrade Study Tutor and Crossroad applications by 
performing a standard installation according to the 
installation instructions earlier in this guide. 

STUDY TUTOR AND CROSSROAD UPGRADE – 
LOCAL LICENSING 
If you have decided to use local licensing, you can upgrade 
Study Tutor and Crossroad applications by performing a 
standard installation according to the installation instructions 
earlier in this guide. After the installation is completed the 
product license should be entered into teacher conputer as 
follows: 

1. Browse to the following location on the teacher 
computer: C:\Program Files\Sanako\Study\Tutor.  

2. Double click the TutorBasicLicenseUpdate.exe file 
3. Enter your license information to the License Number, 

Responsible license holder and Licensed user ID 
fields 
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CONFIGURING STUDY SYSTEM 

CONFIGURING TUTOR SPECIFIC SETTINGS 
After installing Study 500/1200, the system should be 
configured to ensure the best possible system functionality.  
Most Tutor specific settings are available under the Tutor tab 
in the Tutor application Preferences. To open the 
Preferences window, start the Tutor application and then 
open the Tools menu and select Preferences.  
All the information in the Tutor tab is saved in a .TCF file 
(Tutor Configuration File). 

 
The above window includes settings for Application 
language and Folders. 
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Application language determines the Tutor interface 
language. The default selection for the interface language is 
English. Additional interface languages can be selected in 
the drop down menu. 
Folders settings allow you to define default locations for 
different folders that are accessed by Study Tutor and 
Student. It is recommended that these folders are located in 
a separate file server. 
Note: The Tutor’s class directory can also be located on the 
local teacher computer.   
The table below provides information on the folders and their 
access rights: 

Folder Purpose Of The Folder Teacher Access 
Required 

Student Access 
Required 

Tutor’s class directory Storage area for 
teacher’s class files 

Read/Write/Manage No Access Required 

Student files collection 
folder 

Collecting student 
recordings 

Read/Modify Hidden Write 

Session files folder Sharing teaching 
content. Subfolders for 
sessions A,B,C,D,E,F 
and Tutor will be 
created under this folder 

Read/Write/Manage Read 

Media files folder Storage area for 
different media source 
files, which can be used 
during teaching 
activities 

Read/Write/Manage Read 

Web policy files folder Saving Web policy files, 
which are used during 
the Web browsing 
activity 

Read/Write/Manage No Access Required 

Document files folder  Storage area for 
document files which 
are used during the 
reading practice activity 

Read/Write/Manage Read 

Exam files folder* Storage area for exam 
files, which are used 
during the Exam activity 

Read/Write/Manage Read 

Exam result files  
collection folder* 

Collecting exam result 
files from students 
during the Exam activity 

Read/Modify Hidden Write 

*These folders are needed only if SANAKO Study Examination Module 
has been purchased 

CLASS FILES AND TUTOR CONFIGURATION FILES 
The purpose of Class Files and Tutor Configuration Files is 
to store tutor and classroom specific information in Study 
500/1200. Each tutor has their own personal Tutor 
Configuration File, but they can have multiple Class Files. 
When tutors open the Study 500/1200 application they need 
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to select their own tutor name and the class file that they 
want to use. 

OPENING STUDY 500/1200 FOR THE FIRST TIME 
After Study 500/1200 Tutor application has been installed it 
is ready to be configured for further use. When the Tutor 
application is started for the first time, the only available login 
option is Anonymous tutor.  

 
While logged in as Anonymous, you can create tutor names 
for all the tutors that will be using the system. However, the 
name and directory settings for the Anonymous tutor cannot 
be edited.  

ADDING A NEW TUTOR 
In order to add a new tutor to Study 500/1200, open the 
Tools menu and then select Admin and Add/Remove 
Tutors… 

 
You can now enter a new tutor name that will be used for 
logging into the Study 500/1200 Tutor application. To set the 
folder where the new tutor’s class files are saved, click on 
the Browse button.  
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After a new tutor has been added to the system, a tutor 
specific Tutor Configuration File (.TCF) is created 
automatically by the system. 

 
When you have entered a tutor name and defined a folder for 
the tutor’s class files, click on Save and then exit the Study 
application. When the Study application is restarted, the new 
tutor name is available in the log in window.  
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CLASS FILES 
Class files are files that store information on the current 
classroom layout, including student names, groups and 
default activities.  
Each Tutor can own multiple personal class files (.CCF) and 
can select which class file they want to use when logging in. 

 
Tutors can also manually open, save and remove class files 
by opening the File menu and selecting Class file. 

 
When a class file is saved for the first time, a window opens 
where you can name the class file and then save it. If you 
save the file as a Template Class File, the class file will be 
available for all tutors when they log in.  
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If changes have been made to the classroom settings during 
a lesson, Study will automatically ask you whether you want 
to save the changes when the Tutor application is closed. 

 

SAVE LOCATION FOR CLASS FILES (.CCF) 
To set the location where the Class Files are saved, open 
the Tools menu and select Preferences and then the Tutor 
tab.  

 

TUTOR CONFIGURATION FILES 
Tutor Configuration Files are files that contain the personal 
settings of each tutor, including: 

• Tutor name 
• Save folder for class files (.CCF)  
• Interface language selection 
• Session file folder 
• Student file collection folder 
• Program shortcuts for application launch 
• Last used class file 
• Auto scan interval 
• Auto scan order 

Each tutor has their own Tutor Configuration File (.TCF) 
which is created when a new tutor is added into Study 
500/1200. 
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STUDY SYSTEM SETTINGS 

You can set general Study system settings in the Settings 
tab of the Tutor Preferences window.  

 

WLAN  
Disabling the screen transfer operations will deactivate all 
screen transter features in Study. This is beneficial in 
wireless environments where using the screen transfer 
operations could slow the system down.  

THUMBNAIL  
Set the default time for updating thumbnails and snapshots 
of student screens. 
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AUTOSCAN  
Set the default time that each student screen is displayed 
during the autoscan function and select the order in which 
the student screens will be shown. 

FOLDERS  
Set the folder that will be used to update the student 
applications. Please note that the student computers must 
have access rights to the student application update folder. 
Checking the Allow file transfer from local folders option 
will allow the teacher to copy and launch files to students 
from any local folder. The students do not need access rights 
to the folder, since the launched file will be copied to the 
student computer. This will also apply when a file in a local 
folder has been selected as the media source and when the 
copy and launch function is used with a file in a session file 
area. 

AUDIO  
Stream Tutor media files means that when a file is used as 
the audio source to students, the audio is sent as a VOIP 
stream instead of the students opening the file.  
There are two different ways of monitoring student audio in 
Study.  
If Stream the student media file while monitoring is 
selected, the student audio is streamed to the teacher as a 
VOIP stream during monitoring. The teacher will hear the 
student’s microphone and any media file that the student 
may be listening to.  
Note: Student microphone cannot be monitored during an 
activity, if the media source is Tutor player, CD audio or an 
External source. 
If Monitor input line is selected the mixer audio lines are 
monitored and you can choose what you’ll be able to hear 
when monitoring students. Stereomix allows you to hear 
whatever the student hears. Microphone means you will 
hear the student microphone during monitoring. 
Note: Regardless of the selected option, if students are 
monitored while they are recording their voice, only the 
student voice can be heard.  
The Tutor Media Player option allows you to select the 
default Tutor media player, which can then be used as a 
media source during the different Study activities.  
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INTERNET  
The Internet options allow you to block Internet ports and 
Web browsers. 

Enable internet blocking will disable all Internet traffic on 
student computers when the teacher uses the ‘Disable 
Internet’ function in the Tutor application PC Control 
features.  

Block other browsers during Web activities allows the 
Web browser applications opened by the teacher, but 
prevents students from opening any other browser 
applications. 

SCREEN TRANSFER 
The Screen Transfer settings are used when a Tutor or 
Student screen is shared to others. 
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STUDY AUDIO SETTINGS 

TESTING SOUND HARDWARE COMPATIBILITY 
SANAKO Study includes an inbuilt application for testing 
whether the sound hardware on a given computer is 
compatible with Study. To test your sound hardware 
compatibility, open the Tutor or Student Tools menu and 
select Sound Hardware Test Wizard.  

STUDENT AUDIO LEVELS 
To adjust the mixer level settings for a student, open the 
Student Tools menu and select Admin and then Settings.  
Note: In order to access the Admin settings you need to be 
logged in with Administrator rights.  

 
The Mixer pre-set values allow you to set default audio 
levels for the player 
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Clicking the Apply and export button creates a registry file 
of the current audio levels, which can then be, for example, 
launched with the Tutor application to student workstations in 
order to ensure that all computers have the same default 
audio levels. 

SETTING DATA PROPERTIES FOR SAVED 
AUDIO FILES 
To set data properties for saved student recordings, open the 
Student Tools menu and then select Settings.  
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STARTING THE STUDY SYSTEM 

STARTING STUDY TUTOR 
After the installation, you are ready to start Study. To start 
Study Tutor, open the Windows Start menu (lower left corner 
on your screen) and select Programs – SANAKO Study 
1200 – Tutor. 

CREATING A DEFAULT CLASS 
When you start the Tutor application for the first time, the 
main window of Study opens without any student icons. You 
can now add students to the classroom and create a default 
class layout.  
To add student computers to the classroom, click on Show 
Corridor at the bottom of the Tutor application. This opens a 
dialog displaying all the student computers in the classroom 
that are switched on. 

 
You can now select the students you want to include in the 
class. To add all the students to the classroom, click Select 
All and then Add to session A. The student icons are now 
added to the classroom. 
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To save the current classroom layout as the default class, 
open the File menu and then select Class file and Save. 

STARTING STUDY STUDENT 
To open the Study Student interface, click the Windows Start 
menu and select Programs – SANAKO Study Student – 
Study Student. The teacher can also at any time display or 
hide the Student applications on student workstations by 
clicking on the Student Applications button on the Tutor 
interface. 
Even if the Study Student application is not open on the 
student screen, it is always running in the background 
listening to commands from Study Tutor when the 
workstation is on. 

STUDENT ICONS 

CLASS VIEW 
The Study class view is a graphical layout of your class. Your 
students are displayed as student icons that reflect their 
current status. 
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The student icons are also color-coded according to the 
session they are in, allowing you to see at a glance, which 
session the students belong to. 

ADDING STUDENTS 
To add more student workstations to the current classroom: 

1. Click on Show Corridor at the bottom of the Tutor 
screen 
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2. This opens a dialog displaying all the student 
computers in the classroom that are switched on. 

 
3. Select the students you want to add and click Add to 

session A, or if you want to assign them to specific 
sessions, click Add selected students to session… 

4. The added students are now displayed on the 
classroom view. 

MOVING AND ARRANGING STUDENT ICONS 
You can rearrange the student icons on the layout to 
correspond with your actual classroom. Open the Tools 
menu and select Admin – Move and align student icons… 
to open a panel with commands for moving and arranging 
student icons. 

 
To move a student icon, select Move and hold your mouse 
button down over the student icon. 
To align student icons, select one of the alignment options, 
hold your mouse button down and drag the mouse pointer 
over the student icons that you want to align. 
You can also move student icons at any time by holding 
down the Ctrl and Shift buttons on your keyboard and 
holding your left mouse button down over a student icon. 
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REMOVING STUDENTS 
To move a student from the class back to the corridor, right-
click a student icon and select Send to corridor. The 
student can then be selected to another class by another 
teacher. 
To remove a student and the student icon from the class 
view, right-click a student icon and select Exclude from 
class (and layout). Once the student icon is removed, the 
classroom configuration can be saved as a new class. 

VIEWING PRODUCT INFORMATION 
Open the Tutor or Student Help menu and select About to 
open a window displaying product information, your software 
version, and the Study modules that you have installed. 
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